Any information contained in these operating instructions may be changed without prior notice.

OKM does not make any warranty for this document. This also applies without limitation to implied assurances of merchantability and fitness for a specific purpose. OKM does not assume any responsibility for errors in this manual or for any incidental or consequential damage or loss associated with the delivery, exploitation or usage of this material.

This documentation is available "as presented" and without any kind of warranty. In no circumstances OKM takes responsibility for lost profits, usage or data losts, interruption of business activities or all kind of other indirectly damages, which developed because of errors in this documentation. This instruction manual and all other stored media, which are delivered with this package should only be used for this product. Program copies are allowed only for security- and safety purposes. The resale of these programs, in original or changed form, is absolutely forbidden.

This manual may not be copied, duplicated or translated into another language, neither in part nor completely, over the copyright matters without the prior written consent of OKM.

Copyright ©2018 OKM GmbH. All rights reserved.
Table of contents

1 Introduction ........................................................................................................................................ 5
  1.1 Preface ........................................................................................................................................ 6
  1.2 Important Notes ............................................................................................................................ 7
    1.2.1 General Notes ...................................................................................................................... 7
    1.2.2 Possible Health Hazards ...................................................................................................... 7
    1.2.3 Surrounding Area .................................................................................................................. 7
    1.2.4 Voltage .................................................................................................................................. 7
    1.2.5 Data safety .......................................................................................................................... 8
  1.3 Maintenance and Services ............................................................................................................ 8
  1.4 Danger of Explosion during Excavation ...................................................................................... 8

2 Technical specifications ..................................................................................................................... 11
  2.1 Control unit .................................................................................................................................. 12
  2.2 Wireless data transfer .................................................................................................................. 12
  2.3 Computer, minimum requirements .............................................................................................. 12

3 Scope of delivery .................................................................................................................................. 13

4 Data transfer via bluetooth ............................................................................................................... 15
  4.1 Installation of bluetooth software ............................................................................................... 16
    4.1.1 Install software and driver .................................................................................................... 16
    4.1.2 Configurate bluetooth dongle .............................................................................................. 18
    4.1.3 Setup connection .................................................................................................................. 21
  4.2 Uninstall bluetooth software ......................................................................................................... 21

5 Control elements ............................................................................................................................... 23
  5.1 Control unit .................................................................................................................................. 24
  5.2 Bluetooth Headphones ................................................................................................................. 25

6 Assembly .............................................................................................................................................. 27

7 Operating modes ............................................................................................................................... 30
  7.1 Ground Scan .................................................................................................................................. 32
    7.1.1 Preparing a ground scan ....................................................................................................... 32
    7.1.2 Conducting the measurement .............................................................................................. 34
  7.2 Live Sound .................................................................................................................................... 35
    7.2.1 Preparing live sound ............................................................................................................ 35
    7.2.2 Conducting a scan ................................................................................................................ 36

8 Field procedure .................................................................................................................................... 38
  8.1 General scanning procedure ......................................................................................................... 39
    8.1.1 Scan Mode ........................................................................................................................... 39
    8.1.2 Regulation of the number of impulses per scanning path ..................................................... 40
  8.2 Special advices for field procedure ............................................................................................... 42
    8.2.1 Orientation of probe ............................................................................................................. 42
    8.2.2 Parallel or Zig-Zag? ............................................................................................................. 43
    8.2.3 Tips from the trainers themselves ........................................................................................ 44

OKM GmbH
www.okmmetaldetectors.com
Table of figures

Figure 4.1: Start screen when inserting in the software CD .......................................................... 16
Figure 4.2: Installation of bluetooth software, step 1 .................................................................. 16
Figure 4.3: Installation of bluetooth software, step 2 .................................................................. 17
Figure 4.4: Installation of bluetooth software, step 3 .................................................................. 17
Figure 4.5: Installation of bluetooth software, step 4 .................................................................. 17
Figure 4.6: Installation of bluetooth software, step 5 .................................................................. 18
Figure 4.7: Installation of bluetooth software, step 6 .................................................................. 18
Figure 4.8: Installation of bluetooth software, step 7 .................................................................. 19
Figure 4.9: Installation of bluetooth software, step 8 .................................................................. 19
Figure 4.10: Installation of bluetooth software, step 9 ................................................................. 20
Figure 4.11: Installation of bluetooth software, step 10 ............................................................. 20
Figure 4.12: Installation of bluetooth software, step 11 ............................................................. 21
Figure 5.1: Overview of control elements of the control unit .......................................................... 24
Figure 5.2: Bluetooth headphones with accessories ................................................................. 25
Figure 6.1: Using the detector in vertical mode ............................................................................ 28
Figure 7.1: Establishing a wireless data connection ..................................................................... 31
Figure 7.2: Configuring Ground Scan .......................................................................................... 32
Figure 7.3: Selecting vertical or horizontal ground scan mode .................................................... 33
Figure 7.4: Graphical representation of Ground Scan ................................................................. 34
Figure 7.5: Ground Scan in vertical and horizontal mode ............................................................. 34
Figure 7.6: Configuring Live Sound .............................................................................................. 35
Figure 7.7: Graphical representation of Live Sound ................................................................. 36
Figure 7.8: Probe should always point downwards and should not be turned .................................... 37
Figure 7.9: Pivoting or turning of the probe falsifies the measurement ........................................... 37
Figure 8.1: Starting position of a scan area .................................................................................. 39
Figure 8.2: Scan modes to measure an area .................................................................................. 40
Figure 8.3: Effects of changing the number of impulses and their distance .................................... 41
Figure 8.4: Comparison of low and high number of impulses ...................................................... 41
Figure 8.5: Different walking speeds during scanning ................................................................. 42
Introduction
1.1 Preface

Dear customer,

all of the engineers, sales, training and support staff at OKM GmbH would like to thank you for your purchase of the Future 2018.

The Future 2018 detector works on the principle of Electro-Magnetic Signature Reading (EMSR). Besides the detection of metallic objects this device is also capable of detecting natural features of the earth like formations of strata, cavities, voids, faults, ground water and other non-metallic objects. Then of course this equipment is best suited at detecting sepulchers, treasure, buried utilities, tanks and the like.

The Future 2018 is able to locate, document and analyze buried objects within various structures and vessels non-intrusively without having to excavate the area. Using EMSR is particularly useful in areas where detection is a must and excavation is not possible. The facile and flexible handling of the Future 2018 can easily and quickly give reproducible results.

With our team of specialists we guarantee that our products are under recurrent control. Our specialists try to implement new developments in terms of further quality improvements for you.

By purchasing or using one of our products, we cannot guarantee that during the course of your research that you will be successful and have a find. The recognition of hidden and buried objects depends on a huge number of factors. As you well may know there are different soil types all over the world with different levels of natural attenuation. Variable soil properties can and will hamper and alter ultimate scan measurements. Areas where there is an extreme amount of ground water, varying clays, sands and wet soils making scanning more difficult and may reduce the maximum depth capabilities of any and all detection equipment, regardless of make or model.

For more information regarding where this equipment has been used and operated, please visit our web site. Our equipment is constantly being tested and when improvements or upgrades are available, we will list them also on our web site.

It is necessary for our company to protect our developments and all of the information learned during the “Research and Development” phases in creating our technology. We strive to stay within the given framework of legislation, patents and trademark registration.

Please take your time to read this User Manual and familiarize yourself with the operation, functionality and how to utilize the Future 2018. We also offer training for your equipment in our factory and on-site. We strive to maintain worldwide dealer network for assistance and support. Please visit our web site for more information.
1.2 Important Notes

Prior to using the Future 2018 and its accessories, please read these operating instructions carefully. These instructions give information on how to use the detector and potential sources where precautions should be taken.

The Future 2018 and its accessories serve for the analysis, documentation and detection of sub-surface anomalies and ground disturbances. The recorded data of the ground structure will be transmitted to a PC to give a visual representation using our proprietary software program. Any additional notes to the software should be observed. Please read the user manual of the software!

1.2.1 General Notes

Being an electronic device, the Future 2018 has to be treated with caution and treated with care as with any electronic device. Any failure to observe the safety precautions given or any use for purposes other than the ones it is designed for may result in damage or destruction of the processing unit and/or its accessories or connected components.

The device has a built in anti-tampering module which will destroy the unit if it is improperly opened. There are no end user serviceable parts on the inside of the unit.

1.2.2 Possible Health Hazards

If used properly this device normally does not pose any health hazards. According to current scientific knowledge, the high-frequency signals are not harmful to the human body on account of their low power.

1.2.3 Surrounding Area

When moving this unit from a cold place to a warmer place, watch out for condensation. Do not immediately operate the unit until any possible condensation could have evaporated. The unit is not weather proof and water or condensation can destroy the unit.

Avoid strong magnetic fields, which may occur in places where there are large electric motors or unshielded loudspeakers. Try to avoid using this equipment within 50 meters (150 ft) of this type of equipment.

Metallic objects on the ground such as cans, tin, nails, screws or debris can influence your scan data and present negative results regarding your scan data. Also it is a good habit to remove any metallic objects off of your person like cellular telephones, keys, jewelry, etc... Do not wear steel toe boots.

1.2.4 Voltage

The power supply should not be outside the indicated range of values. Use only approved chargers, batteries and rechargeable batteries which are included in the scope of delivery.
1.2.5 Data safety

Data errors can occur if:

- the range of the sender module has been exceeded,
- the power supply of the device or the batteries are too low,
- the cables are too long,
- the unit is operating too close to devices which send out disturbances or
- atmospheric conditions (electrical storms, lightning, etc...).

1.3 Maintenance and Services

In this section you will learn how to maintain your measuring instrument with all included accessories to keep it in good condition a long time and to get good measuring results.

The following list indicates what you absolutely should avoid:

- penetrating water
- strong dirt and dust deposits
- hard impacts
- strong magnetic fields
- high and long lasting heat effect

To clean your device please use a dry soft rag. To avoid any damage you should transport the device and accessories always in the appropriate carrying cases.

Prior to using your Future 2018 please be sure that all batteries and accumulators are fully charged. Also allow the batteries to completely discharge before recharging them, regardless if you are working with the external battery or with internal accumulators. This way your batteries will have a long and durable life.

To charge the external and internal batteries, use only the approved chargers which are part of our scope of delivery.

1.4 Danger of Explosion during Excavation

Unfortunately, the last two world wars also made the ground in many places of the world a potentially explosive scrap heap. A host of those lethal relics are still buried in the ground. Do not start digging and hacking for an object wildly when you receive a signal of a piece of metal from your device. Firstly, you might indeed cause irreparable damage to a truly rare find, and secondly, there is a chance that the object reacts in an insulted way and strikes back.

Note the color of the ground close to the surface. A red or reddish color of the ground is an indicator of rust traces. As regards the finds themselves, you should definitely pay attention to their shape. Curved
or round objects should be a sign of alarm, especially if buttons, rings or little pegs can be identified or felt. The same applies to recognizable ammunition or bullets and shells. Leave that stuff where it is, do not touch anything and, most importantly, do not take any of it home with you. The killing machines of war made use of diabolical inventions such as rocker fuses, acid fuses and ball fuses. Those components have been rusting away in the course of time, and the slightest movement may cause parts of them to break and be triggered. Even seemingly harmless objects such as cartridges or large ammunition are anything but that. Explosives may have become crystalline over time, that is, sugar-like crystals have formed.

Moving such an object may cause those crystals to produce friction, leading to an explosion. If you come across such relics, mark the place and do not fail to report the find to the police. Such objects always pose a danger to the life of hikers, walkers, farmers, children and animals.
Technical specifications
The following technical indications are medial values. During operation small variations are quite possible. Technical changes due to development are possible!

2.1 Control unit

Dimensions (Length, Diameter) ................................................................. 950 mm, 65 mm
Weight ........................................................................................................... about 2.5 kg
Protection Class ....................................................................................... IP40
Operating time (internal battery) ............................................................... approx. 12 hours
Charging time (internal battery) ................................................................. approx. 3 hours
Input (charger socket) ................................................................................ 19 V DC / 3.16 A
Processor / Main CPU ............................................................................... Cortex M3, 32 MHz
Processor / Slave CPU ............................................................................... Cortex M0, 24 MHz
Sensor technology .................................................................................. SCMI-15-D
Sample rate ............................................................................................... 1024 values / second
Measurement resolution ......................................................................... 16 bit
Operating temperature ........................................................................... -10 – 60 °C
Storage temperature .................................................................................. -20 – 70 °C
Audio ........................................................................................................... Bluetooth headphones
Air humidity .............................................................................................. 5 % – 75 %
Waterproof ............................................................................................... No

2.2 Wireless data transfer

Technology ................................................................................................ Bluetooth
Frequency range ......................................................................................... 2.4 – 2.4835 GHz
Maximum transfer rate ............................................................................ 1 Mbps
Receiving sensitivity .................................................................................. -85 dBm
Maximum range ......................................................................................... about 10 m

2.3 Computer, minimum requirements

The indicated technical parameters should help you to choose of a suitable computer to analyze your measured scan data.

CD-ROM drive (internal or external) .......................................................... min. 4x
Interface (data transmission) ..................................................................... USB
Free disk space ........................................................................................... min. 50 MB
Working memory (RAM) .......................................................................... min. 256 MB
Graphic card .............................................................................................. min. 128 MB, OpenGL-compatible
Operating system .................................................................................. Windows Vista, Windows 7, Windows 8, Windows 10
Scope of delivery
In the following section you can find all standard equipment and optional parts of Future 2018. The scope of delivery can be different in some circumstances because of some optional accessories which are not included in the basic equipment.

<table>
<thead>
<tr>
<th>Description</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control unit (vertical and horizontal sensor)</td>
<td>1</td>
</tr>
<tr>
<td>Bluetooth headphones</td>
<td>1</td>
</tr>
<tr>
<td>Software &quot;Visualizer 3D&quot;</td>
<td>1</td>
</tr>
<tr>
<td>Bluetooth dongle</td>
<td>1</td>
</tr>
<tr>
<td>Holder for Tablet PC</td>
<td>1</td>
</tr>
<tr>
<td>Windows Tablet PC</td>
<td>1</td>
</tr>
<tr>
<td>Telescopic rod assembly</td>
<td>1</td>
</tr>
<tr>
<td>Carrying case</td>
<td>1</td>
</tr>
<tr>
<td>User manual</td>
<td>1</td>
</tr>
</tbody>
</table>

*Table 1: Scope of delivery*
Data transfer via bluetooth

In this section you will learn how to install the bluetooth software on your computer. This software is necessary to transfer all measured data from your Future 2018 to the computer.
4.1 Installation of bluetooth software

In the first section of this chapter it will be explained how to install the bluetooth software. Please note that the represented figures do not necessarily correspond to the current version of your operating system or the version of usb installation.

4.1.1 Install software and driver

The bluetooth software is situated on the software CD which is included in the scope of delivery. Place the CD inside the CD Rom drive of your computer and wait until a window like shown in figure 4.1 appears.

Click on the entry Bluetooth, to start the installation of the bluetooth software and follow the instructions on the screen of your computer, like it is explained in the following steps.

Step 1

Select the language and click on the button "OK".

Figure 4.1: Start screen when inserting in the software CD

Figure 4.2: Installation of bluetooth software, step 1
Data transfer via bluetooth

Step 2
Click on “Next >”.

Step 3
Mark the entry "I accept the terms in the license agreement" and after that click on “Next >”.

Step 4
Click on “Next >”.

Figure 4.3: Installation of bluetooth software, step 2

Figure 4.4: Installation of bluetooth software, step 3

Figure 4.5: Installation of bluetooth software, step 4
Data transfer via bluetooth

4.1.2 Configure bluetooth dongle

After restarting your computer the bluetooth software should open automatically. Check if you can find the bluetooth icon (grey/white) on the down right side of the task bar.

If you do not find this symbol there, you should start the bluetooth software manually. In this case just click on the bluetooth symbol, which has been created on your desktop during the installation.

Restart your computer after finishing the installation, to agree to the changes on your system!
Now the bluetooth drivers will be installed on your computer. This can take several minutes, depending on your computer. Please wait until all drivers are installed successfully and then continue with step 9.
Step 9
Click in the menu on “View → Service window”, to see the installed services.

Figure 4.10: Installation of bluetooth software, step 9

Step 10
Behind the entry “Serial Port A” you can find the assigned COM port, which you should select during the data transfer in the software Visualizer 3D.

In our example here it is COM6.

Figure 4.11: Installation of bluetooth software, step 10
4.1.3 Setup connection
When you connect the device via bluetooth for the first time, to transfer data the computer, you should enter the bluetooth passkey. The passkey is **OKM** (take care to write in capital letters!).

---

**Step 11**

When connecting the device to computer the first time you should enter the bluetooth passkey.

Enter **OKM** in capital letters and click on "OK".

---

**Figure 4.12: Installation of bluetooth software, step 11**

---

**Step 12**

When the bluetooth connection is established successfully the bluetooth symbol in the task bar will be visible in green.

Only after the bluetooth connection is successfully established, you can transfer data from your measuring instrument to the computer.

The measuring instrument should establish the bluetooth connection always by itself. It is not possible to search for the device via the bluetooth software. You only can use the bluetooth dongle delivered with the device!

---

4.2 Uninstall bluetooth software
In this section it is explained how to delete the bluetooth software from your computer.

Therefor click on the entry **Start > All Programs > IVT BlueSoleil > Uninstall BlueSoleil** and follow the instruction on the screen of your computer. After uninstalling your bluetooth drivers you should reboot your computer.
Control elements

In this section you will learn more about the fundamental use of all control elements for this measuring instrument. All connections, inputs and outputs are explained in detail.
5.1 Control unit

Figure 5.1 represents all control elements of the control unit of Future 2018. The control unit itself is the scanning probe that can be used in vertical or horizontal position.

**Battery LED:** The battery LED indicates the current charge state of the internal battery during operation. As long as this LED shines green you have enough power to run your device. When this LED starts blinking you should recharge the battery.

**Socket for Charger / Charge LED:** When the green battery LED is blinking during operation you have to recharge the internal battery by connecting the appropriate charger to the socket for charger. As long as charging is in progress the charge LED is shining orange. When the charge LED turns off the battery is fully charged.

**Trigger with LED:** Push the trigger to power on the detector. The LED shines green now and the device is trying to establish a Bluetooth connection. As soon as the connections is established the LED turns blue. Now you can use the trigger to initiate a new scan line (ground scan) or to do a ground balance (live sound). To switch off the unit push the trigger for at least 3 seconds until the LED turns off.
5.2 Bluetooth Headphones

The Future 2018 can be operated with any Bluetooth headphone available on the market. Your Future 2018 already comes with Bluetooth headphones similar to figure 5.2.

Before you can use your Bluetooth headphones with the Future 2018, you must establish a wireless data connection to your Tablet PC. After the connection has been established and the trigger LED shines blue the device is ready for headphone pairing requests.

Power on your Bluetooth headphones and push the pairing button. After a short while the pairing should be finished and you can use your headphones.

The Future 2018 tries pairing the Bluetooth headphones only after a wireless data connection has been established. In that way potential interferences between both Bluetooth interfaces can be avoided.
Assembly

In this section is explained how to assemble the device and how to prepare a measurement.
If you are using the Future 2018 in vertical mode (live sound, ground scan) as shown in figure 6.1 there is no additional preparation necessary.

![Figure 6.1: Using the detector in vertical mode](image)

If you like to use your detector in horizontal mode (ground scan) you have to do some additional preparations. Please pay attention to the following steps!

**Step 1**

Attach the detector via T-mount to the telescopic rod assembly. Make sure the trigger button points to the right and the arrow marker pointing downwards to the ground.
Step 2

Mount the holder for the Tablet PC on top of the rod’s handle. Please pay attention to not lose the flat knurled nut.

Step 3

Finally you need to place the Tablet PC into the holder to operate the unit remotely via software application.
In this section you will learn more about operating the device. Every operating mode will be explained in a proper subsection.
The Future 2018 is both control unit and scanning probe and offers the following operating modes and functions:

- **Ground Scan**
  Conduct a graphical 3d measurement for detailed analysis on a computer.  
  *You can use the detector in vertical and horizontal mode.*

- **Live Sound**
  Process an acoustical magnetic field measurement to detect ferrous metals.  
  *You can use the detector in vertical mode only.*

The choice of the operating mode depends on the planned mission. Normally you should use several operating modes one after another to explore an area. In that way you can obtain as much information as possible from the underground of the scanned area.

No matter what operating mode you will use, the first action is to establish a wireless data connection between computer and detector.

After powering on the Future 2018 - by pushing the trigger button - the trigger LED lights up in green color. Now the device tries to establish a wireless data connection to the appropriate Bluetooth dongle, that came along with the detector. Make sure this Bluetooth dongle has been plugged in into an USB port of your computer or Tablet PC.

![Establishing a wireless data connection](image)

*Figure 7.1: Establishing a wireless data connection*

Also ensure that the Bluetooth software, described in chapter 4 “Data transfer via bluetooth” on page 15, is started on your computer or Tablet PC (see figure 7.1). If so, the detector will establish a Bluetooth connection automatically which results in changing the Bluetooth software icon from blue to green and the trigger LED switches from green to blue to indicate an active data connection. As soon as the trigger LED shines blue you can prepare your Visualizer 3D software according to your chosen operating mode.
7.1 Ground Scan

The operating mode "Ground Scan" allows a graphical measurement of any area for analysis on a computer. For the measurement you can either use the Future 2018 in vertical or horizontal mode.

General information about conducting a geophysical measurement can be read in chapter 8 “Field procedure” on page 38.

7.1.1 Preparing a ground scan

After launching your Visualizer 3D software you have to select File > New from the menu or simply click the icon. Then the dialog from figure 7.2 appears to adjust some scan parameters.

![Figure 7.2: Configuring Ground Scan](image)

The following settings have to be applied:

- **Measure equipment (device)**
  Select “Future 2018” from this list.

- **Transmission method**
  Select “Bluetooth” from this list.

- **Interface**
  Here you have to select the COM port that is used for the wireless data connection. *Please read chapter 4 “Data transfer via bluetooth” on page 15 for more details about the Bluetooth connection software and how to determine the right COM port!*

- **Operating mode**
  Select your operating mode which should be “Ground Scan”.

- **Impulses per scan line**
  Here you enter the number of scan values per scanning path. This number defines how many values will be recorded in each scan line of your measurement. *Please read section 8.1.2 “Regulation of the number of impulses per scanning path” on page 40 for detailed information!*
• **Scan mode**
  Decide to survey your area in “Zig-Zag” or “Parallel” mode.
  *Please read section 8.1.1 “Scan Mode” on page 39 for detailed information about both scan modes!*

Right after you confirmed the new project dialog by clicking the “OK” button, you have to select in what scan position you would like to use your Future 2018.

![Selecting vertical or horizontal ground scan mode](image)

*Figure 7.3: Selecting vertical or horizontal ground scan mode*

You can select between two options:

• **Vertical**
  When using the detector in vertical mode you simply carry the detector in one hand while holding the Tablet PC in the other one.

• **Horizontal**
  When using the detector in horizontal mode you have to mount the detector to the telescopic rod assembly and place the Tablet PC on top of the rod’s handle to get one hand free to interact with the software.

If you have selected one of the options confirm it by pushing the “OK” button. The software is now ready to receive scan data from the detector.
7.1.2 Conducting the measurement

After all parameters have been adjusted the device is ready to start the first scanning path. Beginning from this moment the display will show you the image of the underground soil that gets more detailed over time. An example of this situation is shown in figure 7.4.

![Graphical representation of Ground Scan](image)

**Figure 7.4: Graphical representation of Ground Scan**

Now you can start recording measure values. So go to your start position of the first scanning path and press the trigger button of the Future 2018 or the button of the Visualizer 3D software.

![Ground Scan in vertical and horizontal mode](image)

**Figure 7.5: Ground Scan in vertical and horizontal mode**

Now keep going slowly until you have reached the end of the first scanning path. The device will stop automatically at the end of the line. Now please go to the start position of the next scanning path and
press the trigger button of the Future 2018 or the button of the Visualizer 3D software again. The device will stop automatically by itself at the end of the scanning path.

Continue to measure all further scanning paths until you have recorded the complete measure area. To finish the operating mode “Ground Scan” you have to select File > Stop from the menu or simply click the icon in your Visualizer 3D software.

Information about the scanning procedure in general you will read in chapter 8 “Field procedure” on page 38 of this user’s manual.

7.2 Live Sound

In operating mode “Live Sound” you can research the area in regard to ferromagnetic metals. Primarily this function is an acoustical mode and the usage of a headphone is recommended. It also generates a graphical representation to visualize the highs and lows.

Please note that this operating mode can also react on metallic trash or contamination laying on the surface or near to the surface.

7.2.1 Preparing live sound

After launching your Visualizer 3D software you have to select File > New from the menu or you simply click the icon. Then a dialog as shown in figure 7.6 appears.

Adjust the following parameters:

- **Measure equipment (device)**
  Select “Future 2018” from this list.

- **Transmission method**
  Select “Bluetooth” from this list.

---

Ferromagnetic metals are for example iron, cobalt and nickel. Also other metals or objects, which include traces of such metals can be detected.


- **Interface**
  Here you have to select the COM port that is used for the wireless data connection. 
  *Please read chapter 4 “Data transfer via bluetooth” on page 15 for more details about the Bluetooth connection software and how to determine the right COM port!*

- **Operating mode**
  Select your operating mode which should be “Live Sound”.

Right after you confirmed the new project dialog by clicking the “OK” button, you are ready to start your scan. The software is now prepared to receive scan data from the detector.

### 7.2.2 Conducting a scan

Right after activating the “Live Sound” mode, a constant monotonous sound should come from the device. You can also see a graphical representation of the scan values within the Visualizer 3D software as shown in figure 7.7.

![Graphical representation of Live Sound](image)

*Figure 7.7: Graphical representation of Live Sound*

If you hear too many changes between high and low noise, you should repeat the ground balance. Always make sure to hold the device straight downward (vertical) to the ground, as you would do during the scanning process and run the ground balance by pushing the trigger button of the Future 2018 or the button of the Visualizer 3D software.
Now you can move slowly forward, backwards and sidewards, but should avoid turning the probe. The probe should always point vertical to the ground and should not be turned around its own axis.

As soon as the sound output goes higher or lower, the device has detected a potential metal target right under the position of the probe. In this way it is possible to find small metals near the surface like nails, screws, wires, seals and similar targets.

You should use the operating mode "Live Sound" to remove such disturbing metal pieces from the area that you like to scan. The less metals are laying near to the surface, the better will be your result in the operating mode "Ground Scan". You can also find larger metal targets which are located deeper underground. A general norm is: The larger the target, the deeper it can be detected underground!

Also you can use the operating mode "Live Sound" as a useful pin pointer during the excavations. If you already have dug out a large hole and do not remember where exactly the detected object was situated, you can simply use Live Sound to relocate fast and efficient the target position.

After using this operating mode for a while you should process a new ground balance by pushing the trigger button. To finish the operating mode "Live Sound" you have to select File > Stop from the menu or simply click the icon in your Visualizer 3D software.
Field procedure

This chapter gives practical instructions about the general procedure of scanning an area. The different scanning methods and procedures will be explained in detail.
8.1 General scanning procedure

In general every scan always starts on the bottom right corner of your scan area. Starting from this point, you should walk scan path by scan path, whereby every following path is situated on the left side of its previous path. During walking these lines, the measurement values will be recorded and depending on the selected operating mode either transferred directly to a computer or saved into the memory of the device.

The device stops at the end of each finished scan line, so that the user can find the starting position of the next line. In this way, all paths will be recorded and the area will be measured.

Figure 8.1 shows all 4 possible starting positions and the corresponding first scanning path. Depending on the composition of your terrain you can determine the optimal starting point for your measurement by yourself.

The scanning paths may be referred as “Zig-Zag” or “Parallel” traverses. Also the number of impulses (measure points), which are recorded during one scanning path can be adjusted individually depending on the size of your scan area (length of scanning path).

8.1.1 Scan Mode

There are two general techniques to surveying an area with the Future 2018:

- **Zig-Zag**
  The starting position of two scanning paths next to each other is on the opposite side of the measured area. You will record data on your scanning path and on the return path as well.

- **Parallel**
  The starting position of two scanning paths is always on the same side of the measured area. You will only record data in one way and in one direction, while you should return and walk back to the starting position of the next scanning path without recording data.

Figure 8.2 represents both techniques schematically.
Doing the scan in "Parallel" mode you will start on the bottom right corner of your scan area (point 1) to walk and record a scan path towards the upper right corner of the area. After recording the first line, you should walk back to the starting point and move to the left of the first scan line to start the scan path 2 (point 2), to start there the second scanning path. In this way all other paths will be scanned, until you have reached the left side of your measure area.

Doing the scan in "Zig-Zag" mode you will start also from the bottom right side of your measure area (point 1) to walk and record a scanning path towards the right upper corner of the measure area. Different from the parallel measurement, you should continue recording data while walking back the second scanning path. So you go to the starting point of the second scanning path (point 2) and scan in the opposite direction. In this way, all other paths will be scanned in the scan mode "Zig-Zag" until you have reached the left side of your measure area.

The distance between the scanning paths should be consistent during one measurement but can vary from measure area to measure area. If you mostly look for smaller targets than you should also select a smaller distance between the lines. A standard rule is: The smaller the distance between the paths, the more accurate your scans will be. When you are conducting your first scans the lines should not be too close together to locate possible targets.

### 8.1.2 Regulation of the number of impulses per scanning path

It is possible to select the number of impulses before starting the measurement or selecting the automatic mode ("Auto") to adjust the number of measure points after finishing the first scanning path.

When the number of measure points has been configured, the device will stop automatically when this number has been reached and waits for the start of the new scanning path.

In the automatic mode you should stop the measurement of the first scanning path by yourself, by pressing the appropriate button, as soon as you have reached the end of the first scanning path. This effective amount of measure points will be used for all further scanning paths of this measurement. Starting from the second scanning path, the device now stops automatically after the assumed number of impulses has been reached.
Keep in mind the number of impulses which you have recorded per scanning path. This amount should be entered later in the software program, when transferring the data to a PC, to receive all measured data correctly from your measuring instrument!

There is no special rule for selecting the right number of impulses. But there are different aspects which should be considered. These are some considerations:

- the length of your measured area and
- the size of the objects you are searching for.

A preferable distance between two impulses is about 15 cm to 30 cm. The smaller the distance between two impulses is, the more exactly the graphical representation will be. If you are looking for small objects you have to select a smaller distance, for big objects you can increase the distance between the impulses.

Figure 8.3 shows the effects of the distance and the number of impulses per scanning path for some objects.

![Figure 8.3: Effects of changing the number of impulses and their distance](image)

Figure 8.4 shows the difference between very few impulses (left side) and much more impulses (right side) on the same length of scanning path. Therefor the second record (right side) shows much more details and also smaller objects can be seen.

![Figure 8.4: Comparison of low and high number of impulses](image)

Do not hesitate to record more measurements with different numbers of impulses. For example you can scan a large area before doing a second detailed precision measurement. Especially if searching for
bigger objects you can proceed like this. With this manner you can measure a larger area very quickly and afterward you make new scans localizing the suspect targets.

When conducting a scan it is important to not only make note of how many impulses are being used but to get a clear picture of what you are scanning, it is very important to watch your speed. Every scan line should be measured at the same speed as the previous line.

Figure 8.5 shows what can happen, if you walk at different speeds during your scan.

![Parallel scanning and Zig-Zag scanning](image)

*Figure 8.5: Different walking speeds during scanning*

Using a different walking speed in the scanning paths, will cause displacements in the scanning path. As a matter of fact, a target can get cut into several smaller items or completely lost because it was missed. Later when the data is downloaded for further analysis, speed errors can make a target completely unidentifiable and may be discarded.

In general, the following rule is valid: Keep scans at practical sizes where you can see the beginning and stop lines and can comfortably traverse an area to keep your speed and the distances reasonable.

### 8.2 Special advices for field procedure

There are some aspects which you should take note of when conducting scans. In principle, a scan is only as good as the path that was taken. Making errors while scanning will show up in the final graphical representation also as an error. This will cause frustration and lost time.

Before you start with a measurement in the field, you should think of what you are looking for and if the selected area is suitable. Measuring without a plan usually will produce unacceptable results. Please consider the following advice:

- What are you looking for (graves, tunnel, buried objects, ...)? This question has direct effects on how a scan is conducted. If you are looking for larger targets, the distance between the single measure points and scanning paths can be larger, as if you are looking for small targets.

- Inform yourself about the area, where you are searching. Does it make sense to detect here? Are there historical references which confirms your speculation? What type of soil is on this area? Are there good conditions for data recording? Is it allowed to search at this place (e.g. private property)?
• Your first measurement in an unknown area has to be large enough to get representative values. All further control measurements should be adjusted individually.

• What is the form of the object you search? If you are looking for an angular metal box, the identified object in your graphic should have a form according to this.

• To get better values concerning depth measurements, the object has to be in the center of the graphic, which means it has to be framed by normal reference values (normal ground). If the object is on the side of the graphic and not totally visible an estimated depth measurement is not possible and also measurement of size and form are limited. In this case, repeat the scan and change the position of your scan area, to receive an optimal position of the anomaly inside of the graphic.

• There should not be more than one object in a scan. This will influence the depth measurement. It is useful to scan partial areas over such targets.

• You should do at least two controlled scans to be more sure about your results. This is also important to recognize areas of mineralization.

• Most important rule when dealing with mineralization. **REAL TARGETS DON'T MOVE!** If your target moves then it is most likely mineralization.

### 8.2.1 Orientation of probe

During one measurement the probe should have always the same distance to the ground. Generally we recommend a height of about 5 – 15 cm from the surface of the ground if possible.

In the event that you are going to go over stones, wood or high grass that is higher, start your scan with the sensor higher right from the beginning. In circumstances like these, then perhaps you will need to start the scan with the probe at a height of 2 feet (50 cm) and keep it at that level for the entire scan. It is important to maintain the height, this will eradicate many errors. As a rule, do not change the height during a scan for it may create unnecessary errors.

Another important aspect is the physical orientation of the probe. During the "Parallel" scan mode the orientation of the probe does not change because you are always measuring in the same direction. Even in the "Zig-Zag" scan mode the orientation of the probe must not be changed. That means you are not allowed to turn yourself with the device and the probe at the end of the scanning path. Instead you should walk backwards and continue scanning. Otherwise your obtained graphic includes red or blue stripes. These stripes throughout a scan are commonly referred to as "Rotational Errors".

### 8.2.2 Parallel or Zig-Zag?

For skilled users of the Future 2018 both scan modes are suitable. According to experience the best graphics has been received in the "Parallel" mode, because you are starting at the same point and traveling in the same direction. It is also easier to control your walking speed.
Especially in uneven territories like mountain sides, acclivities or other inclined layers the parallel mode is preferred. When it comes to speed, the experienced user will very often use the Zig-Zag mode for the initial scan to determine if there are anomalies in the area worth further research.

8.2.3 Tips from the trainers themselves

When conducting scans, there are some extremely important items that need to be noted. First of all it is crucial that you relax. When you are tense, you are putting too much pressure on yourself to do the scan correctly; often resulting in errors.

- Newly buried targets are difficult to see. Many users receive the equipment and the first thing they do is go out and bury an object. When an object goes into the ground it changes the natural signature of the soil and creates some kind of noise. Usually the buried object has a weaker signature than the unnatural noise and therefore is not detectable. So taken scan images will not show the buried item but visualize the noisy area in blue colors. After the item has been seasoned, meaning it has been in the ground for a complete cycle of seasons (usually a year), the noise gets reduced and the signature of the buried object becomes visible again.

- Train on known targets. In the training course at the factory we have several objects that have been buried for years, just like real targets in the field. These targets can be quickly and easily identified because they are not natural to the soil. Other targets that you can use in your own area are buried utilities. Pipes, tanks, electrical, sewers, graveyards, etc... Most of these items can be found in every community, town or city. This is where you need to begin your training if you are going to self-train.

- Get professional training. When you take advantage of receiving the training, either from the factory or a qualified dealer, you will understand not only the use and operation of the OKM detector but also the software so much easier and be able to identify targets as well as errors.

- Do not rely on just one scan measurement. So many users go out into the field and they make a measurement and see a target. Instead of repeating the scan and reproducing it several times, they go out and get a shovel and dig. On very rare occasion will the first scan be perfect. Even the trainers do multiple scans to ensure that they are not looking at areas of mineralization or an error.

- Soil Mineralization – Oh! Very frustrating! We will all experience it. When you are in an area that is known to have pockets of mineralization, be prepared to conduct more scans than normal.
  - Clay is probably the number one foe. Depending on the iron content of the clay will determine how strong the attenuation will be. A quick rule of iron content is how dark it is, it can vary from a light gray up to a dark orange. The darker the more iron it will have in it.
  - Sand is usually very clear and easy to hunt in. There are two factors of sand that need to be noted. Sand where the ground water is very shallow, meaning that the ground water is usually just a couple of meters from the surface or desert sand where it is very arid. In desert sand, the targets can be situated 3x deeper than indicated.
○ Farmland is another area to take note of. In modern farms, so many nutrients and fertilizers are introduced creating an unnatural area of mineralization.

○ Rocky mountainous areas. Areas with many mountains are also riddled with patches of mineralization. Mountainous areas are created from faults in the earth and this is probably the biggest area for natural treasures as well as mineralization.